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Air Fight 1.0
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Air Fight 1.0

by K-Soft

You fly a plane in enemy batlefield. Test your skills against different enemies
while trying to rescue your peoplg lost in the combat zone. 256 color graphics and
digital sound under Windows 3.1.

486/33 or better required (Sound optional).



BadLands BlackJack
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Text includes INTRODUCTION, DISCLAIMER, INSTALLATION,
TROUBLESHOOTING, and where to find ADDITIONAL HELP

Feb. 18, 1995 EnQue Software
Version 1.00 25700 East 203rd. Street
Pleasant Hill, MO 64080
Voice/Fax: 816-987-2515
24 Hr BBS: 816-566-2956
E-mail Addresses: KHuck116@aol.com or DrBoyd@aol.com

INTRODUCTION
Welcome to "BadLands BlackJack", EnQue Software's first game in the "Vegas

at Home Series" for Windows. This is not just another simple BlackJack game with
boring graphics and silly sounds, it's a full simulation complete with stunning ray-traced
graphics and digitized cards and voice. Top that off with the ability to customize your
rules and strategy charts, and instructions on how to learn to beat the odds, and you have
a complete, entertaining, and instructional BlackJack tutor right at home. If you ever
have or ever will play BlackJack for "real" money, or you simply like to relax and try
your luck, (or skill?), then this game's for you - it can make you a winner!

We recommend a minimum of 4-Meg of memory, a 256-color or higher video card,
and a sound card.

DISCLAIMER
We hate this legal mumbo-jumbo but we gotta do it!

While we at EnQue strive to provide the highest quality software at very affordable
prices, we cannot account for all user configurations and actions. Therefore, use of this
product constitutes an "assumption of risk".

We make no expressed or implied warrranty of any kind with regard to this software and
documentation. In no event shall the authors or EnQue Software be liable for incidental
or consequential damages in connection with or arising out of the performance or use of
this product. Furthermore, we make no recommendations that you do or do not gamble
for real money, and make no guarantees or assumptions as to your success or failure.

TROUBLESHOOTING
NOTE: According to Microsoft, Windows is the ideal game environment because

it handles all the details such as graphics card and audio board support; you write
software to a common specification and Windows handles all the details. While this is
true to some extent, we have found that many of these drivers are buggy - we have gone
to unbelievable lengths to work around these problems but we cannot account for every
configuration. (There are tens of thousands!). Therefore, some of you will have trouble,



and in all likelihood, some of you will not be able to run "BadLands BlackJack". We
apologize in advance for this.

While we are unable to return your calls should you need assistance, we will be happy to
answer questions via E-Mail, BBS, or FAX. Most problems will be driver related and we
may be unable to help you - we cannot test all possibilities and may refer you to your
hardware vendor. However, here are some guidelines.

-- WINDOWS LOCKS UP

If windows locks up and you see the opening screen, it is most likely due to a sound card
problem. Try the two tests described under "no music" and "no digitized voice" below.
If these don't work, consult your sound card manual or supplier. If they do work, please
send us E-Mail with configuration information about your system so that we can attempt
to resolve the problem.

Here are some more guidelines.

1) Try closing off all other applications.

2) Exit Windows, power your machine down then back up, and try again.

3) Re-install the software.

4) Try changing your video driver as described in your Windows manual and
video card manual.

If it STILL doesn't work, we're out of ideas: sorry!!! Drop us a note outlining your
configuration and problems in as much detail as possible and we will try to resolve the
situation.

-- NO MUSIC

Music is played using windows standard MIDI interface. If you can playthe MIDI file
BBJ.MID (in the directory you installed BlackJack) using Media Player or one of your
sound card programs, then they should work in our game.

-- NO DIGITIZED VOICE

Sound is played using windows standard WAV interface. If you can play the WAV files
(in the directory you installed BlackJack) using Media Player or one of your sound card
programs, then they should work in our game.

-- NO GRAPHICS
See above "Windows locks up" section.

ADDITIONAL HELP
Additional help about the game itself, as well as information on ordering other EnQue
games is available once you are running the program. Good luck and thanks for playing
our game - let us know what you think!

@ All Trademarks are Copyrights of their respective companies.



--- END ---
Balru

Path: \titles\BALRU\
Please read the on-line help file for further information.

Black Dog Cribbage

Path: \titles\BDCRIB\

Black Dog Cribbage is an excellent game of Cribbage for Windows. As intuitive to play
as Windows Solitaire, you're sure to find it an addictive diversion. Optional in-game
instructions guide you through the game like cue cards. Shareware ($15 U.S.) actively
supported by an enthusiastic crib player.

Version 1.1 includes the ability to count your own hand + other requested features.
CompuServe customers can register on-line - GO SWREG, ID 2149.

Bingo v. 2.51

Path: \titles\BINGOV\
BINGO Version2.51

Copyright 1993,1994, and 1995 by
Michael A. Maners
All Rights Reserved

Introduction

BIN G O Version 2.5 is a Win 3.x game for (1) one player.

This game is distributed as shareware and has a registration fee of $ 10.00.

Please register this game. The game is not disabled in any way, please distribute this
game. You have (4) four randomly generate Bingo cards to play with.You can choose
between (10) ten different BINGO patterns to play. Numbers are drawn randomly until
you or the computer calls BINGO. You start with 100 pts. and lose 10 pts.

when the computer calls BINGO and can win up to 10,000 pts. when you call a BINGO.

The Menu Bar

The main menu bar contains two entries. "GAME" and "HELP".

"GAME" contains :

"OPTIONS" - Used to select various game options.

"SINGLE GAME" - Allows you to pick and play any single game you wish.

"5 GAME SESSION" - The computer picks five games at random for you to play.
"ANIMATE BALL" - Allows you to select/deselect the BINGO ball to be animated.
"HIGH SCORES" - Displays the top five (5) high scores and players names.
"EXIT" - Used to exit BINGO.



"HELP" contains:
"PATTERNS" - Provides a menu selection to the 10 BINGO pattern examples used in the

game.
"ABOUT" - Displays the About screen.

The Main Screen
The Main Screen contains your (4) BINGO cards, the Number Board w/ variable speed
number draw slide bar, a Start/Stop button, an Animated BINGO ball, a BINGO button

and displays your current score.

BINGO Cards

The numbers on the cards are selected at random before the start of each game. The
BINGO patterns are no longer shown in light blue on each card.

Examples of the (10) ten BINGO patterns are now accessable from the main screen
menu bar under "HELP" or the menu bar of the patterns form.

Number Board

The Number Board is used to highlight all of the numbers called during each game. The
numbers that will be used in the game are shown in GRAY.

The number that has just been called will be shown in YELLOW. The numbers that have
been called during the game will be shown in RED. Numbers not used during the game
will not be shown.

At the head of the Number Board the name of the BINGO pattern that you are playing is
displayed. At the bottom , a count of the numbers called is displayed.

Variable Speed Number Draw

Just underneath the Number Board is a slide bar. The slide bar is used to set the speed at
which the numbers are called. Fastest <> Slowest, left to right. In the left most position

the numbers are called approximately one every second, to the far right about one every

ten seconds. The default is set at about 4-5 sec. The speed can be changed during a game
and will take effect after the next number is drawn.

Start/Stop Button

The Start/Stop button is used to.... class, anyone? correct Start and Stop a BINGO game.
The Stop button will pause a game in progress.

The Start button will Start a new game or continue a game in progress.

Animated BINGO Ball
An Animated BINGO ball has been added for your added pleasure. If you do not wish it
to be animated, deselect Animate Ball under "OPTIONS" from the main screen.

BINGO Button

When you think that you have a BINGO click this button. If you have a good BINGO
you will be rewarded points based on how many numbers have been drawn, the fewer the
better. If you do not have a BINGO the game will inform you of that fact. If you call
BINGO incorrectly more that a few times per game it will reflect in your score.



How the Game is Played

A game of BINGO will start when you click the start button, or choose the New Game'
option under 'Game' from the main screen menu bar. if you have not typed in your name
as the current player or selected a BINGO pattern to play, you will be

asked to do so at this time.

When you notice a number drawn that is on one or more of your BINGO cards

use the mouse to select that number by placing the arrow inside the box containing the
number and click the left mouse button, the box with the white background w/ black
numbers will change to a red background w/ white numbers to acknowledge a correct
selection. A number must be selected the for it to be part of a good BINGO. The game
continues until you or the computer calls a good BINGO.

You may select to play a new game or BINGO pattern at any time you wish.

When you exit the game, if your score is the new high score, it will be saved at this time.

Shareware Registration

BINGO Version 2.5 is distributed as shareware, and has a registration fee of $ 10.00.To
register BINGO Version 2.5 send your NAME & ADDRESS, along with a

check made payable to Michael A. Maners to:

Michael A. Maners
3170 Crow Canyon Pl. Suite 135
San Ramon, CA 94583

I can also be reached for comments, suggestions and questions:
Fax @ (510) 355-1433

CompuServe @ ( ID 73114,74)

America Online @ Mychall7

Internet Mychall7@aol.com



Where you can find BINGO vX.X
The latest version of BINGO can be found in many places, I have listed some of the ones
that I UpLoad/Distribute to:
CompuServe - GO WINFUN
America Online - Windows Board/Card Games.
PsL News - P.O. Box 35705
Houston, TX 77235-5705
Info : (713) 524-6394

BINGO Version 2.51 Enhancements
This version is only an address change from version 2.5.

BINGO Version 2.5 Enhancements

Below are the enhancements of version 2.5 over version 2.0.

1) Ability to save your top five (5) scores.

2) Ability to play a five (5) game session.

3) Animated BINGO Ball.

4) What's missing? New BINGO patterns! I have decided to add new BINGO patterns
into version 3.0 and only for regestered users.

BINGO Version 2.0 Enhancements
Below are the enhancements of version 2.0 over version 1.0.

1) Six new BINGO patterns added. I had said I would add four, but what the heck.

2) Improved game Al. Some of you may have noticed with version 1.0 the computer won
after 49 numbers were drawn, no longer.(Note: If you think that a BINGO pattern is to
easy or to hard, please let me know.)

3) Improved BINGO pattern examples. I removed the light blue patterns from the bingo
cards and replaced them with discriptive examples.

4) Improved scoring. Some patterns pay more than others and a new way to lose points
also.

5) Fixed a couple of BUGS. Nothing major.

6) What's missing? On-Line help! I have not finished writing it yet. More work than I had
thought. I hope the added features and extra bingo patterns make up for the loss.

Why Version 2.5 ?

The main reason for BINGO Version 2.5 is because of interest overseas for the game.

I needed to spruce up version 2.0 and include information for overseas users. Also I have
been very busy with my day job and could not finish version 3.0 for overseas distribution.
I am working on version 3.0 as you read this and hope to be completed in a

BINGO Version 3.0

BINGO Version 3.0 will include at least (5) five new bingo patterns, Highlight winning
BINGO's, and a pull tab game. In future versions I will add On-Line help, sound, more
animation, an enhanced high score table and will continue to add new BINGO patterns,



and maybe even a network version if there is interest. Lastly thanks to all of you wh

Enjoy
1/28/95
Michael A. Maners

Brain Jam
Path: \titles\BRAINJ\

Brain Jam will run only under Windows 3.x and compatible operating systems.
It consists of the files BRAINJAM.EXE, BRAINJAM.HLP, and README.TXT.

Copy these files to your hard disk. To install Brain Jam in Program Manager, select the
File menu and then select New... In the dialog box that then appears select Program Item,
then click on OK. In the Program Item Properties dialog box fill in the Command Line
box with the full path of the BRAINJAM executable. For example, if you have copied
Brain Jam to the C:\BRAINJAM directory, type C:\BRAINJAM\BRAINJAM.EXE into
the Command Line box. In the Description box type Brain Jam.

Then press OK. The Brain Jam icon should now appear in the currently selected program
group. You may drag and drop this icon into any other program group if you wish.

If you use a desktop manager other than Program Manager, please consult the
documentation for that product.

Once you have activated Brain Jam by double-clicking on its icon, select the Help menu
for full instructions on using and registering Brain Jam.

Brain Jam comes in shareware and commercial/registered versions.

The version can be identified by clicking on the Help/About menu.

Generally the shareware version may be redistributed while the commercial version may
not; for further information consult the Legal Matters section in the online Help.

Ordering and registration information can also be found in the online Help.

Should you wish to contact us, please send email to one of:
Internet: 72133.3027@compuserve.com
Compuserve: 72133,3027

or write to:

Brain Jam Publications

P.O. Box 62024

1448 Lawrence Ave. East, #19
North York, Ontario

Canada M4A 2W1



Version History

1.9 - card faces are copied from Microsoft Solitaire, which must be resident in the
WINDOWS directory.
If not, a procedurally generated set of cards is used.

- fixed a nasty bug that would crash some video drivers after winning a game or trying to
exit the program.

1.8 - updated list of winnable games in the range 0-49
- solutions are kept in the file BRAINJAM.SOL instead of
BRAINJAM.INI. If you are upgrading from a previous version,
existing solutions will automatically be transferred from
BRAINJAM.INI to BRAINJAM.SOL. It is recommended that you make
a backup of the BRAINJAM.INI file before doing this transfer.

If you have several old BRAINJAM.INI files
you can merge their contents into BRAINJAM.SOL by following
the procedure for each of the files:

1) rename the file to BRAINJAM.INI

2) load Brain Jam

3) unload Brain Jam
Note that if this INI file contains solutions for games included in
previously transferred files, shorter new solutions will replace the
longer old ones.

1.7 - various bug fixes

1.6 - improved game selection and review, keyboard interface
1.5 - improved "Deal" function

1.4 - corrected problems with illegitimate game numbers

1.3 - first public release

Canasta for Windows v. 2.5

Path: \titles\CANASTA\

CANASTA FOR WINDOWS V2.5

Strategy cardgame played against the computer, using artificial intelligence.

With sound & music support. The player wins by melding cards and by making canastas.
A canasta is a column of seven cards (i.e. seven Kings).

Help file with explanation of all rules is included. Many options are included to make the
game completely configurable. Supports multiple resolutions, up to 1024x768.



Requires Windows 3.1, Color VGA display and a mouse. Sound card is optional.

Cribbage Pro v1.3

Path: \titles\CRIBBPRO\

Cribbage Pro v1.3 <ASP> - A Comprehensive Card Game for Windows 3.1 - CP provides
all the features and challenge you expect from a traditional cribbage game. Multiple
playing and scoring levels, from beginner to expert and automatic to muggins. Easy
interface for effortless play. Screen components result in great visual appeal. Whether
beginner to expert, Cribbage Pro has something for you.

Duel! v.2.0

Path: \titles\DUEL2\

* Duel! v2.0 *

by Guy Gervais

What is it?

Duel! is a game of starship battle. Two players duke it out in orbit around a central sun.
Inspiration came from chapter 8 "Star Trek Dynamics" of the book "The Tinkertoy
Computer" by A.K. Dewdney.

The game is written in Visual Basic and works better on fast machines with large screens.
It will play on a 386 at 640x480 but isn't as enjoyable.

This game is shareware. It is fully functional, and doesn't nag. If you enjoy it, please send
108 to the address listed at the end of this document.

Installation

Copy DUEL2.EXE to the directory of your choice. The file THREED.VBX should be
placed in your \WINDOWS\SYSTEM directory. Make sure you don't overwrite a more
recent version before copying it.

You also need VBRUN300.DLL which isn't included but can be easily found on most
Compuserve Forums. I didn't include it to keep the size of the zipped file small.

You can create an icon for Duel! by dragging the DUEL2.EXE from the File Manager to



a group in your Program Manager.

How to play

See "Instructions" and "Controls" under the Help menu in the game.
The game is pretty straightforward and a couple of tries should be enough to figure out
how everything works.

Contacting the author & registering.

For comments and/or suggestions, you can E-mail my CompuServe
account at 71242,2425.

For registration, please send 10.008$ to the following address:
Guy Gervais
7175 Michelet, apt. 23
St-Leonard
Quebec, Canada
H1S 2L8
Registered owners will be sent a new version if one becomes available.

That's it.

Double Dynamite Video Slots v. 1.1

Path: \titles\DYNAT11\

DOUBLE DYNAMITE VIDEO SLOTS v1.1

This isn't your grandmother's slot machine! This is a nine wheel video slot machine with
8 pay lines. Also has bonus spins, "wild card" symbol, and a progressive bonus pool.

See the beautiful graphics and animation for yourself!
Requires VBRUN300.DLL (not in .ZIP file)

F18 No Flight Zone

Path: \titles\F18NFZ\
Please read the on-line help file for further information

Fructus

Path: \titles\FRUCTUS\



Please read the on-line help file for further information
Glass Bead Challenge
Path: \titles\GLASSB\

Glass Bead Challenge

Copyright (c) 1995 Creativision Publishing Corp.
All rights are reserved.

Mail: Creativision Publishing Corp.
P.O. Box 5523
Arlington, TX 76005-5523

Voice: 817-656-5970 (M-F, 9-5 CST)
FAX: 817-656-7794 (24hr)
Internet: cvpsupport@aol.com

America Online: CVPsupport
Compuserve: 70404,3014

PROGRAM INFORMATION

Glass Bead Challenge is an ORIGINAL game of strategy for one or two players.
Dominate your opponent without capturing any pieces! Multiple computer levels, several
board sizes, 16 and 256-color graphics with digitized sound and music. FUN!

GETTING STARTED

To install, follow these directions:

1. Copy the program files to your hard drive, or you can install the program from your
floppy drive.

2. Make sure that the file VBRUN300.DLL is either:

A. In the same place as the program files, -or-

B. In your Windows SYSTEM directory, where it can be shared with any other Visual
Basic Application.

3. From Windows, run the program BEAD.EXE (from Program Manager select the
"Run..." option from the File menu)

4. If you want, you can easily create an icon in Program Manager by selecting the "New"
option from the file menu. The file you want to add is "BEAD.EXE"; it is fairly easy to
browse for it in the New Program dialog.



TECHNICAL SUPPORT
If you encounter a problem that is not covered in the Help file, you will probably need to
contact us for user support.

A. Mail us a letter at:
CreatiVision Publishing
Technical Support
P.O. Box 5523
Arlington, TX 76005-5523

B. Use EMAIL:
Internet - cvpsupport@aol.com
AOL - CVPSupport
CompuServe - 70404,3014

C. Call or fax us at:
Voice - 817/656-5970 (Hours: M-F, 9-5 CST)
Fax - 817/656-7794 (24 hours)

When contacting us we need the following information:
1. The make and model of your computer
2. The type of display
3. The version number of Windows you are running
4. The amount of memory your machine has

NOTICE: We reserve the right to decline technical support to any unregistered user in
order to better serve our registered customers.

LICENSE INFORMATION

As an unregistered user you are granted a limited license period of 7 DAYS for a free
evaluation of this product. If you continue to use after that point you must register the
program. If you do not register you must discontinue its use.

REGISTRATION

Only $14.95 -- PLUS you get a FREE GIFT!
(See the "Buy Me" menu in the program for complete ordering info)

DISTRIBUTOR INFORMATION

This is shareware and as such, anyone is permitted to give copies to friends or associates.
However, if you are a distributor of shareware products, we ask that you read the



following text BEFORE distribution.

TRADEMARKS

Glass Bead Challenge is TM CreatiVision Publishing; Windows and Visual Basic are (R)
(C) Microsoft Corp.; IBM is (R) International Business Machines Corp.

DISCLAIMER, COPYRIGHT NOTICE

In no event will CreatiVision Publishing be liable to you for any damages, lost profits,
lost savings, or any other incidental or consequential damages arising out of the use

or inability to use this software, even if CreatiVision Publishing has been advised of the
possibility of such damages, or for any claim by any other party.

This product is freely distributed as shareware with a 7-day trial license before purchase.
All copyrights on the name, look-and-feel and operations are strictly

enforceable. It is illegal to change any text within the program code that would remove
the copyright notice for CreatiVision Publishing. It is also illegal to

change ordering information text in the program or to distort in any way the identity of
the rightful copyright holder.

THANK YOU!

Gold Monkey v.2.1

Path: \titles\GMONKEY\

Gold Monkey 2.1 is an exciting MS-Windows strategy game!

Use all your wits as you try to fill the screen with bananas. It is simple to learn and play,
but only the craftiest will be a Top Banana! Can you beat the Top 5? Can you cruise the
diagonals with finesse? Try this colorful, addictive logic test by Gold Software, Inc.

Special Requirements: Windows 3.x

GoMoku Narabe v.2.0

015 \GOMOK2\GOMOKU.EXE /

GoMoku Narabe v2.0 (GOMOKU.EXE) is a Windows shareware version of the ancient
Japanese game of 5 in-a-row. But it is more than just a game -- it is also an introduction
to some interesting Japanese culture and a good "jumping off point' to explore a
fascinating and accessible area of Mathematics. Please peruse the Help file

(by choosing 'Help/How to play' from the menu) after you have loaded and started the
game to learn more about these three facets of Gomoku Narabe.

GoMoku Narabe is written in Visual Basic 3.0. As such it requires that



VBRUN300.DLL exists in your Windows System directory.
The GoMoku Narabe files that make-up GOMOKU.ZIP include the following:

README.TXT -- This Read Me file

GMCLEAR.WAV -- The sound of the board being cleared
GMCLICKO0.WAV -- One of three 'stones hitting the board' sounds
GMCLICKI1.WAV -- "

GMCLICK2.WAV -- "

GMWIN.WAV -- The oriental gong sound that signals a win
GMZILLA1.WAV --'GoZilla's' deep, evil laugh
GMZILLA2.WAV --'GoZilla's' deep, evil groan

GOMOKU.EXE -- The GoMoku Narabe executable
GOMOKU.HLP -- The GoMoku Narabe Windows help file
TAKECHILTXT -- Yoshinori Takechi's copyright file for the 5 MIDI Koto pieces
HANABA.MID -- 'Hanabana' MIDI file

KOTGOT.MID -- 'Kogogoto' MIDI file

KOTSUN.MID -- 'Kotsun' MIDI file

SAKURA.MID -- 'NeoSakura' MIDI file

TUBAKIMID -- 'Tubaki' MIDI file

Please note: The MIDI files are copyrighted by Yoshinori Takechi and must not be re-
distributed unless accompanied by the " TAKECHIL. TXT' copyright file.

I have a install program that takes care of everything having to do with installation but for
file exchanges across BBSs it takes up too much room -- adding almost 300K to the files.
So . .. to install GoMoku Narabe, please do the following:

1. Check that VBRUN300.DLL is in your Windows System directory. If not,
please download a copy and place it there (there should be a copy
on the BBS from which you downloaded GOMOKU.ZIP; maybe as VB300.ZIP,
VBRUN300.ZIP, or VB3DLL.ZIP, etc.).

2. Create a directory GOMOKU.

3. Copy all of the GoMoku files (they are listed above)
to this new GOMOKU directory.

4. Create a program manager icon for GOMOKU.EXE by adding it as a file
in your GAMES program manager group.

That's it.

Thanks for using GoMoku Narabe. I hope its challenging, fun, and educational at the
same time!



Steve Neeley

Bad Toys v.1.0

Path: \titles\badtoys\

BAD TOYS Shareware v1.0 for Windows

(C) 1994,1995 Tibo Software

GIVE SHAREWARE BAD TOYS TO EVERYONE YOU KNOW!

THIS GAME MAY BE FREELY DISTRIBUTED

Files in badtoys.zip

badtoys.exe
data.pck
firm.msg
regform.txt
readme.txt
file id.diz

Installation instructions

1)
Copy all files to any directory (c:\titles\badtoys).

2)
From windows, choose new from the file menu of program manager when
the games window is active. Choose new program item.
Use browse to find location of BADTOYS.EXE. Set the working
directory to the same directory that the game files are in.

More information you can find in help of BAD TOYS.



If you want to own next levels you should register now.
See 'How to register' in help.

PLEASE, DON'T DISTRIBUTE MODIFIED COPIES.

Solitaire Othello v.1.02

Path: \titles\ICARE \

| SOLITAIRE OTHELLO |
| version 1.02 |
- -

Program written by Luc Riviere, compiled with Borland Pascal 7.0 for
Microsoft Windows.

You will need a PC-compatible computer (80286 or above), a version of

Microsoft Windows 3.0 (or above), and a VGA card for this program to
function properly.

What is SOLITAIRE OTHELLO ?

Solitaire Othello is designed as a training exercise that will help you solve Othello
endgames, as well as give you hours of enjoyment trying to solve the thousands of
puzzles. It is presumed that you already know the rules of OTHELLO, which is also
known as REVERSI.

A game of Solitaire Othello consists of finishing a game of Othello in progress when
there are only a few moves left (in between 6 and 12 empty squares). The program will
indicate your objective for this game: for example, 'Black to play and win!' or "White to
play and draw!".



The problem and the challenge is that there is one and only one series of moves that will
allow you to achieve that objective.

In case you don't play the correct move sequence (for example you invert the order of two
moves) the computer will take great pleasure in making your goal impossible, since Icare
will always play the move that gives itself the highest possible final score.

So, a game of Solitaire Othello is very similar to a labyrinth that you must find your way
out of. You stand within a hallway and there are many doors (legal moves) to choose
from. Each door you go through gives you another choice. There is one and only one
series of doors to pass through to find the exit, and every other path will lead to a dead
end. Don't forget that in most Othello endgames, the best move can normally be found
with a little bit of care. To help you out, I would recommend reading the book "A la
découverte OTHELLO" edited by the French Othello Federation, or the book "Brief
and Basic" from the United States Othello Association.

(the addresses are given at the end of this file)

ICARE gets its name from this analogy, since "care" is required when choosing moves.
You will learn quickly that simple rules of vhumb (such as always taking as many discs
as possible, and always take a corner given to you) are not the most effective, particularly
in the last few moves of an Othello game.

It is always possible to achieve better results than a computer, provided a solution exists

for each problem. This is comforting if we compare ICARE to other stronger Othello
programs which are available (CASSIO or THOR, for example).

How does ICARE work?

When the program is started, you see the following things in the window:

- the menu line.

- a game of Othello with a nearly completed game on the board.

- a window indicating the origin of the game (the tournament and the
players).

- a window indicating the objective of this game (the colour you must play,
and whether your goal is to win or draw).

- the number of discs that each player has in the current position.

- a clock which counts down the elapsed time (you are given 5 minutes on
the clock for each problem). This clock does not limit the amount of
time you have to solve the problem in any way; it is there for those
who want to pretend they are faced with this position during a tournament.

- a blank area underneath the Othello board where the moves (in the order
played) are listed.



To play, all you need to do is place the cursor over the square where you wish to play. By
clicking on the left mouse button, if the square is a legal move for you, that square is
selected. A second click on that same square is required to play a move there.

All of the menu functions are accessible from the keyboard by pressing the ALT key and
the underlined letter on the menu. The menu functions are:

- Quit: Quit the program.

- New: Selects a new Solitaire Othello position from the database of games.
How a game is chosen from the game database can be changed under the
Options menu (see below). In the beginning, positions are chosen at
random from the database with 8 empty squares in them.

- Start: Go back to the beginning of the current game of Solitaire Othello.
This is useful when you realize you have made an incorrect move, and
want to start from scratch.

- Pass: If you have no legal moves, you must tell the computer that you must
pass by clicking on this part of the menu.

- Back: Takes the position back to your previous choice. Useful when you
make a serious blunder.

- Show: If you can't find the solution, clicking on 'Show' will give you
the next move in the optimal sequence. Successive clicks will
eventually show you the entire optimal sequence.

- Options: Gives you a sub-menu:

- Empty Squares: Allows you to choose how many empty squares you want
on your positions (between 6 and 12). The larger the
number of empty squares, the more difficult the Solitaire
Othello game is to solve. This is a type of difficulty
level.

- Next Choice: Allows you to choose which method the next game of Othello
is chosen. There are three possible methods:

Random: the default mode

Incremental: chooses the next game in the list (the games
are all numbered), for those who wish to make
sure they play all of the games of Solitaire
Othello.

By Dialog: After each game, you will be asked for the



number of the game you wish to play next.
Useful if you wish to replay an interesting
game.

- About: Displays, among other things, the number of games in the database,
as a function of the number of empty squares.

- History: All of the solitaire Othello games given in this program are real
games played in international competitions. History allows you
to see the first moves of the game, and see just how they arrived
at the position you are trying to solve. While in History mode,
a series of buttons appear in the lower right hand corner of the
window which are very similar to a tape recorder.

<<: Returns to the beginning of the game.

<: Goes back one move.

||: Pauses the game at the current position.

> : Plays moves (automatically) from the current position.

>>: End History mode, return to the game of Solitaire Othello.

General Information

Four files are provided to run ICARE on a PC:

ICARE_US.TXT: This file that you are reading right now.
ICARE_US.EXE: The program itself, for installation under Windows.
Copy the files to a directory of your choice.
Choose a program group and click on New... under
the File menu in the Program Manager.
Choose Program Item in the sub-menu.
Fill in the appropriate information.
Size of this version: 125440 Bytes.
ICARE.DBS: The database of Solitaire Othello games. This database can
change with different versions by the inclusion of new games.
It is extracted from the database of games maintained by THOR
(THOR.DBA) with the assistance of a utility that I can make
available to you if you are interested.
BWCC.DLL: Borland library which allow a more robust use of the Windows
resources (in my opinion) than the original Microsoft library.
It is possible that you already have this file (it is probably
in the Windows\system directory), in which case you do not need
this file.

For those who are interested, I can give you the program CREESOLI.LEXE which



allows you to play through the database of games as well as the PASCAL source files and
resources and the file 'Icare.Gif'. This is taken from a GIF picture (Compuserve) created
with the aid of the Vivid ray tracing program. The original image is 640 * 480 * 256
colours and it was reduced to 320 * 240 * 16 colours for Icare.

If you wish to talk to me, my address is:

Luc Riviére

15, rue Henri Dunant
29490 GUIPAVAS
FRANCE

If you don't get a response, it might be because I have moved again. In this case, the
easiest way to contact me is to write to the French Othello Federation (address given at
the end of this file).

The author would like to thank

- Stephane Nicolet, author of the Macintosh program CASSIO, who was
included a similar Solitaire Othello game in his program. To help me,
he gave me access to his Solitaire Othello Pascal source. Although it
was completely re-written for Windows, Stephane was active in the design
of Icare, in particular with the algorithm that decides whether a game
has a Solitaire ending.

- Sylvain Quin, author of THOR, an Othello program for the PC. He had
the wonderful idea to attach a database of games to his program that
contains all of the games played in the principal Othello tournaments
in the world, despite the huge amount of work required to maintain it.
All of the games found in Icare are taken from this database.

- Bruno de la Boisserie, who combines, among others, the title of secretary
of the French Othello Federation and the computer aspects of Othello.
He possesses a vast library of programs which have made history over the
brief history of Othello. I would like to thank him for his efficiency
and availability as a verifier during the design of the preliminary
versions of the program.

- Mark Brockington, for the quick and efficient translation of Icare in
Shakespeare's language.

About ICARE



This program is FREEWARE, which means the author reserves all rights, and
it is forbidden for anyone to modify or sell this program (except for the

small minimal cost of transport or duplication) without the express written
consent of the author.

However, you may copy this program and give it to anyone who is interested
and, of course, use it at any time (I hope you will use it a lot).

If you find this program interesting and you wish to learn more about the
game of Othello, the easiest method is to subscribe for a year to your country's Othello
Federation:

USA: USOA, c/o Clarence Hewlett
920 Northgate Avenue
Waynesboro, VA 22980
subscription rate (1993) $7.00 U.S. (U.S. residents)
$11.00 U.S. (overseas members)

'Othello: Brief & Basic' $6.00 U.S. (U.S. residents)
$5.00 U.S. (USOA members)
$8.00 U.S. all overseas orders
(members & non-members)

France: F.F.O.
B.P. 147
75062 Paris Cedex 02
subscription rate (1993) 90 FF (below the age of 18)

120 FF (Adults)
150 FF (non-France residents)

This money will give you the right to play in rated tournaments and you will also receive
the federation's magazine which will help you improve your Othello skills. Soon, you

will find the problems proposed by this program easy and routine!

As well, the federation will allow you to meet with a number of other Othello players.
This allows the quality and quantity of games to improve, for the benefit of everyone.

Have fun...

Luc Riviere
Angela's Bug Swat
Path: \titles\bugswat\

ANGELA's BUG SWAT INFORMATION:



General:

The program is a game designed to help you improve your Mouse Pointing skills. You
Swat as many bugs as you can during a one minute time limit. Make sure that you hit the
bug in the About Box to relieve your frustrations.

System Requirements:

1. Windows 3.1

2. VBRUN300.DLL installed in the Windows\system
directory. This is a Visual Basic 3.0 Program.

3. VGA Display for best viewing

4. MultiMedia Sound is recommended to hear the bugs
scream, but is not required.

Program Installation:

Install the following files in the directory of your choice.
Note these files must be in the same directory for the program to operate correctly.

. Swat.exe

. SwatRead.txt
. SwatReg.txt
. Bizz.wav

. Swat.wav

. Ow.wav

. Wesur.wav

. Camfl3.bmp
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Install the program in the Program Manager group of your choice.
Refer to your Windows Manual for instructions.

Program Operation:

The objective of the program is to Swat as many bugs as you can in one minute by
clicking on them. You start the swatting by clicking Start. The Speed of the program may
be set at three different levels. The Sound may be turned On or Off (note you

must have MultiMedia sound capability for this feature to be active). You may also
choose a Large or Small Form to play on. You may also turn on the Bug Camouflage if
you are daring enough. The program also has a falling Bonus Bat, but you must Swat him
with the RIGHT Mouse Button to get 5 Bonus Points. All the Bugs



must be Swatted with the LEFT Mouse Button to get 1 point. If you let a Bug get away
you lose 1 point. Please make sure you explore the Help Menu. To end the program Close
the window from the Control Button on the form's top or Click the Stop Sign.

Program Registration:

This program is distributed as Shareware. If your continue touse the program after 30
days, please send $1.00 to:

Mike Murphy
1385 Majolica Road
Salisbury, NC 28147

If you have any comments about or problems with the program you may contact me at
the address above, or on Compuserve at the following address.

CIS User ID - 71160,1275

Liability:

The author has tested this program on his computer and has experienced no problems.
However, due to the large variation in computer equipment and software setup the author
can not guarantee the program's operation on your computer. The author, therefore
accepts no liability for any loss you may associate with the use

of this program. In short you use the program at your own risk.

Space Monkeys v.1.0

Path: \titles\MONKEY\

SPACE MONKEYS v1.0 (¢) 1995 CommonWealth Software

Thank you for taking some time to read the readme.txt file! You can play this
SHAREWARE version of Space Monkeys as much as you like. In fact, you can copy the
game (as long as you include ALL the files) for your friends to play too. However, the
game quits after a few minutes.

You can get a fully functional game by sending $20 to CommonWealth Software,
Katherine Drive, Indianapolis IN 46217. We'll ship out the latest version of Space
Monkeys for you to enjoy --- without any silly timer to shut things down. But just a note:
if you don't like the game, then feel free to play with the shutdown version as much as
you like.



If you like the game, please send in for a fully functional version.

For more support, you can contact us at 74362.1653(@compuserve.com.

SYSTEM REQUIREMENTS

Space Monkeys was tested using a few different computers (486/66) and a

couple of different sound cards (Sound Blaster and compatible). You'll probably need
8Mb of RAM (you know how Windows gets). Beyond that, any IBM type PC should
work with Windows 3.x.

You will need VBRUN300.DLL, SPIN.VBX and THREED.VBX to run this game.
If you cannot find these things around on the 'net, contact Compuserve or us directly and
we'll get you straightened out. Don't suffer without this stuff. It is available at no charge.

Note: You probably should shut down ALL OTHER APPLICATIONS before
playing Space Monkeys. Although we have ran the game with other stuff going, the
graphics get funny if you minimize and maximize all over the place.

INSTALLATION INSTRUCTIONS

1. Make a directory for Space Monkeys. You can do this using File Manager by clicking
on File in the menu and then Create Directory... Type in MONKEY and click OK.

2. Copy monkey.zip to that directory and unzip it using pkunzip. You'll get a bunch of
files. Make sure you don't remove any of them (the game needs those files to run).

3. Create an Icon for it with Program Manager. Click File and then New...
You should get an icon that looks like a banana. Name it Space Monkeys.

4. Click on the banana to play.

5. Please send $20 to CommonWealth Software.

ADDTIONAL NOTES

As of this writing, there are no known bugs in Space Monkeys. However, | have
encountered some problems when playing the game with network drivers installed. Don't
know what causes it, but if you encounter this problem or any others, please contact us at
CommonWealth Software. We don't want faulty games running around on the 'net.



Thanks again for trying this out. Let us know if we can help.
CommmonWealth Software, 74362.1653@compuserve.com
Moraff's Morejongg

Path: \titles\MOREJONG\

*MoraffWare*Best Mahjongg Ever!*For Windows*

Moraft's Morejongg is the finest implementation ever made of the ancient Chinese tile
game! The great game has the following features:

1) Great 3D graphics, very easy to see the 3D levels!

2) Traditional layout, Big tile layout and Mega-Morejongg with 288 tiles!
3) Save games in progress.

4) Customize all the colors, and save your choices.

5) Use any image file any format as a tile set, or make your own!

Also look for the other MoraffWare games

Quatra Command

Path: \titles\QUATRA\
Please read the on-line help file for further information

RECYCLE MANIA!!!

Path: \titles\RECYCL\

>>> RECYCLE MANIA!!! <<<

COOL game for Windows --

Sort falling recyclables in a fast paced TETRIS-style FUNfest!!! Music, digital sound
effects & MORE!!! (Shareware)

Riskit for Windows

Path: \titles\RISKI\
Please read the on-line help file for further information
Schlaumeier v.1.1

Path: \titles\SCLAUM\



Hallo!

Sie haben die Shareware-Version von "Schlaumeier 1.1" erworben.
"Schlaumeier" ist ein Programm fiir Windows 3.1.

Kopieren Sie einfach sm_share.exe und sm.hlp auf Thre Festplatte, und dann kdnnen Sie
auch schon loslegen.

Hinweise zur Vollversion und zur Registrierung finden Sie unter "Einfiihrung".
Viel Spall mit "Schlaumeier"

Thomas Zacharias

Waldemarstra3e 9

Rostock

18057

Tel.:0381/4905805

Solar Vengeance

Path: \titles\SOLVEN\

Please read the on-line help file for further information

CvberTarot v.2.3a

Path: \titles\TAROTW\

CyberTarot(TM) version 2.3a is a complete Tarot reading system for Microsoft
Windows 3.1 or later. You can choose from any of three spreads or card layouts, shuffle
and select your own cards, and view individual cards on a large screen. Comprehensive
on-line help system includes interpretations of individual cards and information about
spreads and card positions.

Minimum configuration requires 256 color VGA, 386 or better CPU, and Microsoft
Windows 3.1 or later. CyberTarot also requires VBRUN300.DLL, which is NOT
included in this ZIP file. Copyright (c) 1994 AxisMundi, Inc.

Moraff's Ultra Blast

Path: \titles\ULTRABL\

MoraffWare - Best Breakout Game! Cool Sound!
Moraft's Ultra Blast is a super-highquality animated arcade game for Windows!



Textured backgrounds, spinning swirls and blinking eyes for balls, full sound!

1) Contains 25 complete levels in thisversion!

2) 16 million color animation! Also supports 16, 256 and 65,536 colors.
3) Keep complete high-score lists.

4) Easy to use screen editor lets you make your own screens!

5) Really cool artwork and sound effects!

Also look for the other MoraffWare games

Warheads v.2.02
Path:; \titles\WARHEA\
Warheads for Windows version 2.02

How to reach the authors
To reach the authors, you can send email to: STEADLE@AOL.COM

System Requirements

Warheads for Windows has been revised since it was initially published in 1991. The
hardware and software requirements are now just a bit different. A list of mimimum
requirements is below:

A 386 Microprocessor

4 MB of RAM

~1 MB of Hard Disk Space
Windows 3.1 or later

A Windows compatible mouse

+ 4+ + +

In addition, to take advantage of Multimedia sound and MIDI you'll need a properly
configured Windows compatible sound card such as the Media Vision ProAudio
Spectrum.

Questions and Answers

Previous versions of this README.WRI file had Questions and Answers in this space.
All questions and answers have been moved to the help file. Please read the help file
topic on User Questions and Author Answers. Any new questions will be placed here.

What's the difference between Version 2.00 and 2.01
Version 2.00 had a bug which caused problems with the use of third party libraries. This

was discovered when the WAR-DINO library was being tested. We quickly fixed the
problem and created the new version. This disk contains version 2.01.



What's the difference between Version 2.01 and 2.02

Version 2.01 does not properly respond to keyboard input. The keys A, and D should fire
missiles from the left and right missile bases, respectively. Version 2.02 corrects this
problem, as well as another problem with General Protection Faults upon exit fro

The cursor/target crosshair freezes during explosions

The problem you describe seems to be related to the way your computer plays sound
effects.

Background on how Warheads creates sound effects:

The older version of Warheads for Windows (versions 1.11 and earlier) used the
Windows 3.0 sound function calls which were made obsolete in version 3.1 (although
they continue to work only for compatability). Windows NT and presumably version 4.0
of Windows

Explanation of the problem:

In order to maximize compatibility with existing Windows setups, Microsoft
implemented a driver which plays multimedia sound effects (Wave Files) through the
ordinary PC speaker. This driver is called the "PC Speaker Driver" and many
manufacturers of comput

The PC Speaker driver is a pretty good solution for normal Windows sound effects.
However, Warheads for Windows is a game that requires maximum CPU bandwidth
(basically all processing power) to keep up with you the user. The PC-Speaker Driver, by
default, i

Sound cards use special circuitry that reduces or eliminates the drain on the
microprocessor. Warheads (and other programs) do not slow down during a sound event
on computers with sound cards since the sound card, and not the microprocessor, handle
the play

The most plausible explanation for delays in game play is that your computer is using the
PC Speaker Driver.

Recommended Solutions
If this is the problem, then you have four options:

1. Turn off the Sound Effects in Warheads. You can use the Warheads for Windows ->
Control Settings dialog box to turn off the sound effects. This is an easy and effective
solution because it only affects Warheads for Windows, and doesn't cost anything

2. Turn off the PC speaker driver. In this case you won't be able to hear ANY sound
effects (both in Warheads and in Windows itself). To do this follow the procedure below:



- Start the Windows Control Panel application (usually found in you "Main" group
inside the program manager).

- Double-Click the "Sound" icon

- There should be a checkbox called "Enable System Sounds" shown on the bottom
left part of this dialog. Make sure that this button is NOT checked, then press the OK
button.

This should effectively disable all your sound effects and Warheads should no longer
pause at each sound effect (missile explosions, city explosions, missile launch, etc.)

3. Configure the PC Speaker driver such that it allows interruption during sound
events. To do this you can follow the procedure below

- Start the Windows Control Panel application (usually found in you "Main" group

inside the program manager).

- Double-Click the "Drivers" icon

- From the list of installed drivers, select the one called "PC Speaker Driver".

- Press the "Setup..." button

- There should be a checkbox called "Enable Interrupts" shown on the dialog.
Make sure that this button is checked, then press the OK button.

- Press the Close button on the "Drivers" dialog box.

- Close the Control Panel.

4.  Buy a sound card (expensive but it is the best solution)

Even though most Windows programs, games included, run perfectly well under OS/2,
are native OS/2 games on our agenda?

Uh, ummm... well, no.... not really. According to Bill Machrone in the January 24, 1995
edition of PC Magazine, OS/2 has been sold to 6 million people. Very few of these people
have written to us requesting an OS/2 version of Warheads. It really isn't econo

We do have some plans for WIN32 / NT based games and have recently ported Warheads
to NT 3.5. It should be released any month now, after a little testing and a change to the

documentation / help file. Look for it on America On-Line in March 1995.

End of Questions and Answers

Happy Gaming and Long Live Grimmy!

Eric Lee Steadle & Brian C. Lowe



Winfish 3
Path: \titles\WINFISH3\
Winfish 3 can be registered On-Line on Compuserve, GO SWREG

To start playing Winfish 3, create a directory to store the game.
Then unzip WF3.ZIP into the directory you created.

Using FILE RUN

Type WF3 to play.

NOTE: There is a MIDI file that plays in the background, if you don't hear the MIDI
music, you may need to load the MIDI Mapper drivers found in Windows Control Panel.
I have gotten it to work on most machines by changing the MIDI Mapper settings.

If you don't get MIDI sound try using the ADLIB drivers, or the General, or Extended
MIDI drivers.

WF3.ZIP contains these files:

wif3.exe - MAIN Winfish 3 EXECUTABLE

REQUIRED VISUAL BASIC CUSTOM CONTROL FILES
mci.vbx
threed.vbx

REQUIRED SOUND FILES:
birdl.wav
bird2.wav
bird3.wav
bite.wav
castdone.wav
castin.wav
castout.wav
closec.wav
crickl.wav
crick2.wav
fishoff.wav
fishon.wav
frogl.wav
frog2.wav
lineinl.wav
linein4.wav
lineout.wav



loser.wav
nice.wav
openc.wav
sethook.wav
splash.wav
startup.wav

river.mid -- Midi Sequencer file

INFORMATION FILES

license.wri - LICENSING INFORMATION
orderfrm.wri - ORDER FORM FOR REGISTERING
readme.txt - THE FILE YOU'RE READING NOW !

OTHER INFORMATION

I can be reached via E-Mail on Compuserve @ 72202,2453
Winfish 3 can be registered On-Line on Compuserve -- GO SWREG -- ID# 5398

ALSO REQUIRED BUT NOT INCLUDED IS:
VBRUN300.DLL - VB RUNTIME DYNAMIC LINK LIBRARY
(VBRUN300.DLL is available on most BBS's and CompuServe)

NOTE: Be Sure to Copy ALL .VBX and .DLL files to your WINDOWS\SYSTEM
directory

NOTE: Registered Version DOES contain VBRUN300.DLL on the diskette.

Herman

Path: \titles\herman\

Welcome to Herman (this game if for MS Windows)

This game is a maze of rocks for Herman to move around. He must collect all of the
flowers to get to the next level. If a rock falls on his head he will die and you will have to
repeat that level.

SHAREWARE: Herman is NOT a public domain program, it is a ShareWare product.

If you choose to keep and play Herman please send $15 to :

Carl Bieling



R.D.#1 Box 1926
Palmerton, Pa. 18071

For $15, I will then send the current version.

For $20, I will then send the current version and include another
set of mazes.

For $30, I will then send the full construction set for building
your own mazes.

Please send any comments or sugestions to the above address or I can
be reached by CIS: 70324,3633

YahtC
Path: \titles\YAHTC\
The following files should be placed in a single directory:

bugle.wav
flush.wav
dice.wav
* sherdnO1.vbx
* grid.vbx
yahtc.exe
yahtc.hlp

* If you wish, these files can be placed in your "windows\system" directory.

The file VBRUN300.DLL must be either in your windows or windows\system directory.
Neither VBRUN100.DLL or VBRUN200.DLL will suffice.

To install the game open up your favorite "games" group in program manager, select
"new item" under "file", and type "c:\yahtc\yahtc.exe". The interface is fairly staight-
forward, but any questions you may have can be answered by clicking on the "help"
item in the menu bar.

If you enjoy the game, please take the time to register it. The registration information can
be found on the "about YahtC" dialog box. If you have any comments or suggestions, or
would like a CUSTOMIZED version of the game, please write. We will answer each and
every inquiry.

P.S. The program can also be registered in the SWREG forum on Compuserve. The
registration ID is 5331.

Jiji and the mysterious forest Ch.1




Path: \titles\jfore\
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Jiji's adventure series - vol.2 *
"Jiji and the mysterious forest" Chapter 1 *
%
Jiji's adventure RPG System Ver.1.0 *
Copyright(C)1994 J1JI Release 1994/04/16  *

Translated by Hitoshi Ozawa *
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Requirement: MS-Windows3.1 or higher
Correct color should appear properly on machines with only 16 colors.
"Jiji and the mysterious forest" is a sequence to "Jiji's fish???

Content Ofthe StOI'y sk sk sk sk sfe sk sk sk sk sk sk s sk sk sk sk sk s sk sk sk sk sk sk s sk sk sk sk sk s sk sk sk sk sk skoskeosk skosk skok

The main character of the story, a black cat named Jiji, continues on a adventure to find
the country of fish.Recently, while starving in the meadow, Jiji sighted a school of fish
flying by. Jiji eagerly sets out chase after them.

[Jiji] "Liit's a fish!!!"

[Jiji] "Oh, no, they're swimming away. Wait for me----!(bumpX\!#&)"

Good gracious, dear me. Jiji, transfixed to the fish, didn't see that big round tree in front
of his path.

[Jiji] "Oooooouch. Oh, no. They're heading into the forest" Jiji, in fervor of chasing after
a school of fish, found himself in front the the deep deep forest.

[Jiji] "Where did the fishes go?"

Jiji catches a glimpse of the fishes swimming ever deeply into the forest.Jiji, mustering
up his courage, decides to enters the forest.

Goal Ofthe game sk st sk s sfe sk sk ok sk sk sk sk sk sk sk sk sk sk sk sk sk sk sk sk sk sk sk sk sk sk sk sk sk sk ok sk sk sk skoskoskosk

Jiji enters the forest from the Northeast side. "The mysterious forest" is just the name Jiji
uses to call the forest, and creatures of the forest calls it the camphor forest. This is
because somewhere deep within the forest lives an age old camphor tree. Before he was
born, the forest used to have a different name, but that was a long time ago. Unknown
years has pasted since that name was uttered, that only few creatures now even remember
the forest had a different name.

Oops, got a little bit sidetracked there, but the goal of this story is to pass through this
camphor forest.

Installation st sk sk sfe sk sk sk sk sk sk sk sk sk sk sk sk sk sk ste sk sk sk sk sk sk sk sie sk sk sk sk sk sk sk sk sk sk sk sk sk sk sk sk sk ko sk sk skoskoskoskoskok .

Files included in the archived file:
Jforest. DOC  The file you are reading right now
Jforest EXE  Execution file



JFGRAPHO.DLL Graphics data file
JNAZO.JRL +- scenario file
JINAZO.FRF +/

JIJ1.JIBS Sound data file

JIUL.MAP Map data file
NYAO.WAV Meow .wav data file
NYA.WAV Unneow .wav data file
WAN.WAV Wan .wav data file

Copy all the files to the same directory. Of course, this file could be deleted after you
finished reading it.

Uninstall sk st sk sk s sfe sk sk ok sk sk st sk sk sk sk sk sk sk sk sk sk sk sk sk sk sk sk sk sk sk sk s sk skoskoskosk sk ke skeskoskosk

The program creates Jforest.ini under the \WINDOWS directory, so you should first
delete this file.

If you saved the story, savefile.dat file is created in the directory where Jforest.exe
resides, so delete this file also.
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AiFGame Window
BiFJij  Window

CiiFMessage Window
DiiFButtons Window

How to Play sk e sk sk sk s sk sk ke sk sk ske sk sk sk ke sk sk sk sk sk sk ke sk sk sk sk sk sk sk sk sk sk sk s ke sk skeosk sk skokesk sk

Jiji is displayed in the center of the Game Window. Move the mouse pointer near where
Jijiis. The pointer should turn into an arrow.

This arrow is points to the direction where Jiji is to move.

Press the left mouse button while the arrow is showing. Jiji should have moved in the
direction of the arrow. Release the button to stop Jiji.



The picture of the Jiji in the current condition is drawn in this windows. Refer to this
picture to decide on when to eat a lunch (* -).

Button WindOW st s sk sk sk sk sk e sk sk sk sk sk sk sk sk sk sk sk sk sk sk sk sk sk sk sk sk sk sk sk sk skoske sk sk sk sk skeoskoskoskok ke skoskosk

* File

Save and load the story in progress. Naturally, you won't be able to load unless you save
a story first.

* Lunch

Eat strawberry and silvervine to regain strength.

This command also appears when right mouse button is clicked in the Game Window and
the Message Window.

* System

1) "My Walking Pace"

Control the scroll speed. Adjustment of this speed depend on your computer speed.
Save this setting by choosing File|Save buttons.

2) Have BGM

Turn BGM on and off.

3) Have sound effects

Turn replay of *.wav files on and off.

* Bye-bye
End the game.
* About

Display copyright message.

Combat Commands sk sk sk sk s sk sk sk sk sk sk s sk sk sk sk sk sk s sk sk sk sk sk sk sk skeosk skok skokosk

* Scratch

Jiji's favorite mode of attack. There's pretty much power behind that scratch.

* Jiji Punch

Not as powerful as the Scratch, but Jiji won't get tired as much. Saying that much, there
probably isn't that much difference. Well, it's probably alright if you always scratch.

* Lunch

When Jiji is totally exhausted during a combat, eat a lunch. Similar to the Lunch button,
Jiji's strength will recover.

* Run-away

Run-away from the enemy. Depending on Jiji's current strength and fate, Jiji may not
succeed in running away.

Bug sk st sk sk s sk sk ok ok sk sk sk sk sk sk sk sk sk sk sk sk sk sk sk sk sk sk sk sk sk sk sk s sk skoskosko sk sk skeskoskoskosk

This program uses System Font. If your system is set to display in other fonts, some
message might not appear correctly.
Also, BGM sometimes will suddenly stop. The causes are still unknown (T _T).

Acknowledgement sk sk s sk sfe sk sk sk ok s sk sk sk sk sk sk s sk sk sk sk sk sk sfe sk sk sk sk sk s ke sk skeosk sk skokosk

For finding bugs and giving other advices, I want to thank NITARIS, DZ, and MD-V-



MAX.
I want to thank DZ especially for the *.wav data (* ")v.

Now fOI' a message fOI' D7, sk sk st st stesteste st st st s s s s s s s s e e e e s sk skokokokok

Thank. I'm DZ.
I promise Jiji that I'll record my cat's voice and made him wait a while. Sorry for that Jiji.

Profile of my cat:
Name: Mi-chan (*_*; simplistic name, isn't it. The real name
seems to be Mi-ko.
Type: Tortoiseshell
Gender: Female
Age: Unknown - because she was a stray cat. Seems she's been here for about 9 years.
[WAVE recorded: April 5, 1994]

Copyright ok ok ok skok o ok ok ok sk ok o stk skok ok ok ok skok sk kokoskok ok koo skok sk kokoskok sk sk okokoskosk sk ok sk sk ok k

Jiji adventure series programs is copyrighted by Jiji.

This program can be distributed only in the original archieved formatted file. Do not
change this file or any files within (*_-).

If this file is going to be distributed, please send a mail to Jiji expressing your thoughts
about the program.

If this program is to be mentioned in any article, especially please send a mail.

* wav files are copyrighted by Mi-chan and DZ. Do not distribute

* .wav files without the program.

Developers of this program will not take financial, legal, nor any other responsiblities for
damages that may result from usage of this program.

JII: Nifty-Serve: VFB01170
Hitoshi Ozawa CompuServe: 100220,3402

The Adventures of MicroMan

Path: \titles\microman\

The Adventures of MicroMan

Adventure 1: Crazy Computers

(Shareware - unregistered version)

Programmed and Developed by: Brian L. Goble



Copyright (¢) 1993 Brian L. Goble

WHAT IS MICROMAN - ADVENTURE 1?

This Text file provides deatiled information. For summary information about this
program, please refer to the README.TXT file.

MicroMan - Adventure 1, is an arcade-action style game for Windows 3.1 developed by
Brian Goble using the Windows Animation Package (WAP) which was also developed by
Brian Goble.

The object of MicroMan is to run, jump, duck, climb and shoot your way past the
enemies while exploring new areas and collecting special powerups!

MicroMan - Adventure 1, is shareware. Use beyond a 30 evaluation period

requires that you register this program with the author. Registered users will receive
Adventure 2 of the MicroMan Adventure Series plus a special bonus Windows
application: WallMan.

You are free to distribute this program as long as all files are included and no changes are
made. It is requested that shareware distributors notify the author.

WHAT FILES SHOULD THE MICROMAN ARCHIVE CONTAIN?

The MicroMan archive should contain the following files:

* MICRO1.EXE

* MICRO1.IMG

* MICRO1.RMP

* MICRO1.WAV

* MICROI1.PG1

* MICRO1.PG2

* MICROL.TXT

* README.TXT
* REGISTER.TXT

WHAT SYSTEM REQUIREMENTS ARE NEEDED TO RUN MICROMAN?

System requirements and recommendations for running MicroMan are:



* Microsoft Windows 3.1 (required)
* 2 megabytes of memory (required)
* 1 meg free disk space (required)

* 386DX processor (recommended)
* 8-bit color graphics (recommended)
* Sound card (optional)

HOW DO I INSTALL MICROMAN?

To install MicroMan, simply copy all the files from the disk (or decompressed
archive) to any directory of your choosing on your hard disk.

HOW DO I RUN MICROMAN?

To run MicroMan, select "Run..." from the "File" menu in Program Manager.
Next, enter the full pathname (e.g. C:\WINDOWS\titles\MICRO1.EXE) and press
the enter key.

Alternatively, you can double-click on MICRO1.EXE from File Manager or you

can create a MicroMan icon in Program Manager. Refer to your Windows documentation
for more information.

HOW DO I PLAY MICROMAN?

To play MicroMan, select "New Game" from the "File" menu (or press Ctrl+N). Press F1
to view the quick reference help screen. Use the arrow keys to move,

the space-bar to jump (hold longer to jump higher) and the "Ins" key to shoot.

To explore new rooms, simply move to the edge of the screen (and keep going)

to enter the neighboring room.

Left Arrow - Move left, aim left (keypad arrows work best)
Right Arrow - Move right, aim right

Up Arrow - Climb up, grab ladder

Down Arrow - Climb down, duck

Space-Bar - Jump (hold space-bar longer for higher jumps)
Ins Key - Shoot a bullet (keypad Ins works best)

The keypad works best for game play--make sure Num-Lock is off. Use your left hand to
jump with the space-bar and place your right hand over the keypad, with your thumb on



the Ins key for firing.

WHAT IF MY SYSTEM IS TOO SLOW?

If your system runs MicroMan too slowly, you can select "Skip Frames" from the
"Animation" menu. This will result in faster, but jerkier animation.

You can also un-select "Energy Bar" from the "Display" menu.

Un-selecting "Fancy Wipes" under the "Display" menu will speed screen transitions when
the game is in "attract" mode.

WHAT IS THE MICROMAN STORY?

MicroMan is the victim of a top-secret experiment that went terribly wrong.

Wearing a special weapons suit, Bob Jones voluntarily stepped into the Molecular
Miniaturizer created by Dr. Schnapps. Dr. Schnapps turned on the power and the
miniaturization process began.

After a few moments of blinding light, Bob Jones was reduced to the size of a few
microns. The experiment seemed to be a success but the Molecular Miniaturizer
suddenly started smoking and a few seconds later, exploded, killing all those in the lab,
including Dr. Schnapps.

Bob Jones, now known as MicroMan, was never found after the explosion.
However, since the Molecular Miniaturizer and it's creator had both been destroyed, it

didn't really matter--there was no hope to return him to his original size.

MicroMan now finds himself in a strange and hostile world where he is one of the
smallest inhabitants. Now, his mission is personal: to explore and stay alive.

HOW DO I REGISTER MICROMAN?

By registering this shareware program, you will receive the following:
* Registered version of MicroMan - Adventure 1 (with cheat mode!)

* Maps, tips, hints, and secrets for MicroMan - Adventure 1



* MicroMan Adventure 2: Savage Stones (new graphics, sounds, and puzzles!)
* Special bonus Windows application: WallMan (with five images!)
To register, send $25 to: ~ Brian L. Goble

2218 Franklin Ave E.

Seattle, WA 98102

Please specify disk size (5 1/4" or 3 1/2") and whether your Windows system
uses 16 or 256 colors.

You can also print the REGISTER.TXT file and use the included registration
form.

It is my goal to create the highest quality games for the Windows environment

in terms of graphics, animation, and playability. Please help support my continuing
efforts by registering this software.

IS THERE A WARRANTY FOR THIS SOFTWARE?

This software is provided "as is". Although the author has made extensive efforts to
make sure no bugs exist in this software, the author claims no responsibility for any
damages you may experience as a result of using this software. Use at your own risk.

If you do find any bugs, please report them to the author.

WHAT IS WAP?

WAP stands for Windows Animation Package. The package implements real
software sprites and flicker-free sprite animation under Microsoft Windows.
WAP was developed for use with 8-bit color but is able to execute on systems
using less than 256 colors as well.

The heart of WAP is the WAP.OBJ file which is linked with the Windows
application that wants to use WAP's services. WAP also consists of 3 utility
applications for capturing sprites, editing rooms/maps, and manipulating palettes.

WAP was developed by Brian L. Goble.



WHAT LANGUAGE WAS USED TO CREATE WAP?

WAP was compiled using Microsoft C/C++ 7.0. No C++ was used however.

WHAT CONCEPTS DOES WAP SUPPORT?

* Sprites

* Images

* Patterns

* Frames

* Pages

* Rooms

* RoomSprites

WHAT SPRITE FEATURES DOES WAP SUPPORT?

* Drawing

* Moving

* Erasing

* Clipping

* Flashing

* Mirroring

* Inverting

* Mirverting

* Removing

* Virtual Frames

* Collision Detection
* Sprite Types

* Sprite States

* Sprite Control Programs

IS WAP EASY TO USE?

WAP is very easy to use. All the low level functions required for flickerfree sprite
animation are carried out by WAP. The programmer merely calls the high level functions
when necessary.



A typical main animation loop might consist of the following WAP routines:

// //
// Example Main Animation Loop //
// //

case WM_TIMER:

WAP_ProcessSprites(IpWAP); // execute sprite control programs
WAP_DrawSprites(IpWAP); // draw all active sprites
WAP_SwapPages(IpWAP); // display new sprites, erase old ones
WAP_CheckSpriteCollisions(IpWAP); // check for sprite collisions

return(OL);
The main programming effort required by the programmer is the coding of the Sprite
Control Programs (SCP). A SCP is a routine that controls a specific sprite.

For example, a simple SCP to animate a sprite walking across the screen to the right
might look something like:

// //
// Example Sprite Control Program for Walking to the Right //
// //

int FAR WalkRight(IpS)

LPSPRITE IpS;

{

if (IpS->MoveState == MS_UNINIT) { /1 if first time, initialize sprite
IpS->MoveState = MS_ WALKING; // set move state to walking
IpS->x = 10; // set initial x coordinate
IpS->y = 50; // set initial y coordinate
IpS->image = 5; // use graphic image #5
IpS->frame = 1; // use frame #1 of image #5

}

else if (IpS->MoveState == MS_WALKING) { // process next frame of walking
IpS->x++; // increment x coordinate

if (IpS->x > 600) { // is sprite at right border?



IpS->SpriteFlags |= SF_ REMOVE; // if done walking, remove sprite
}

IpS->frame++; // use next animation frame
if (IpS->frame > 24) IpS->frame = 1; // if end of frames, wrap to start

}

return(1); // finished - return to WAP
}

So, by using SCP's, the programmer still has full control over all sprite actions and logic
but doesn't have to worry about all the tasks necessary to animate them--WAP performs
these necessary tasks!

HOW CAN I OBTAIN WAP

Currently, WAP is not available on a general, wide-spread basis. However, if you are
working on a finanacially supported software poject and would like to use WAP in your
product, please contact the author for further discussion.

In the future, the author hopes to create proper documentation for WAP so that it can be

made available to all interested programmers--regardless of their experience level
regarding graphics and animation programming.

HOW CAN I CONTACT THE AUTHOR?

To contact the author of both WAP and MicroMan, use:

Brian L. Goble

2218 Franklin Ave E.
Seattle, WA 98102

(206) 322-7932
goble@u.washington.edu

Please contact me if you questions, offers, or comments...I would like
to hear from you.



